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 문헌및서지관리

 PDF 논문파일저장만으로서지
정보자동입력

 웹에서검색한문헌결과를바로
저장

 PDF 리더기가탑재되어있어, PDF 
논문을바로열람하고하이라이트
및연구자노트추가

 온라인동기화를통해서데스크탑
프로그램, 웹사이트, 모바일
디바이스에서시간과장소를구애
받지않고바로문헌을열람

 약 7,000 여개의 Reference Style 
지원되어참고문헌자동생성

• 문헌/서지관리 : Desktop,  Website, Mobile (iOS & Android)를통한문헌관리



Read PDF in Mobile
- iOS, Android
-무료앱설치후, 멘들레이계정로그인

원하는부분선택
하이라이트, 노트추가
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Presentation Notes
If you come across any words or terms you haven’t heard before, simply right click and choose ‘Define’ to look it up. Mendeley will then retrieve definitions and explanations for you.




 동료연구자들과논문공유를통한
연구협력

 이용자가읽은 PDF 논문을 Private 
Group 에올림으로써, 
동료연구자들과공유

 그룹내멤버들과연구에대한의견
교환

 연구협력생산성증대

• 문헌공유 :  Private Group를통한문헌 (PDF file) 공유



 논문검색및 관심문헌자동추천

 전세계 4백만Mendeley 
이용자들이저장하고읽은학술
논문들대상으로논문
데이터베이스형성

 문헌검색과더불어

 이용자가저장한문헌의내용과
주제분야를파악하여관심있을
만한문헌자동으로추천

 연구자가선행연구논문을
검색하는시간과노력을절약해줌

• Suggest : 이용자별관심논문자동추천



Comparison Free Mendeley vs. MIE

Item Free Mendeley
Mendeley Institutional

Edition

Personal library space 2 GB 100 GB

Private Group Space per person 100 MB 100 GB

# of Private Group 5 Unlimited

Private group size 25 100
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PDF 논문및논문서지수집관리
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Presentation Notes
We’ll start by setting up your Mendeley library.




Step 1:
Mendeley web site에서계정
만들기

Step 2:
Mendeley Desktop 프로그램설치

Step 3:
My library 구축

Create account and install program
• www.mendeley.com 에서Mendeley 계정을

만듭니다.

• 계정생성후, 자동으로데스크탑
프로그램이설치됩니다. 

• 기존에 ScienceDirect 혹은 Scopus 계정이
있는경우, 같이사용합니다.
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To download Mendeley, visit our website and sign up for an account. Mendeley will then prompt you to download the Desktop manager. Once that’s installed, you can begin to build your library. 


http://www.mendeley.com/


Join Institution Group –용량확대!
• www.mendeley.com Search 메뉴

선택

• Group 선택

• 소속기관명영문으로검색

• Institution 표기가있는그룹을찾아
그룹명클릭

• Join this group 클릭

• 소속기관도메인의이메일주소
입력하여그룹가입신청
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Presentation Notes
To download Mendeley, visit our website and sign up for an account. Mendeley will then prompt you to download the Desktop manager. Once that’s installed, you can begin to build your library. 


http://www.mendeley.com/
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Verification Email 확인 • ‘’Join this group” 에서이메일입력후

• 이메일받은편집함을확인하여멘들레이이메일을열람

• “Preview this group “클릭

• 그룹으로링크연결후 “Accept Invitation” 클릭



• 멘들레이데스크탑
프로그램을열고

• PDF Full-Text 파일
혹은파일들이
저장되어있는
폴더를선택하여

• My library / All 
Documents 에끌어다
놓습니다. 

My library 구축하기 – Drag & Drop 
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Mendeley makes it easy to add documents. The simplest way is to drag and drop a file right into Mendeley. 



My library 구축하기-Adding Document
• File 메뉴에서 Add Files 혹은 Add Folders를선택하여, 내컴퓨터에저장되어있는 PDF 

파일들을멘들레이에가져옵니다.

• Add Enter Manually –논문파일혹은서지파일이없는경우, 수기로해당문헌의내용을
직접입력하여서지를구축합니다.

• Import : 다른서지관리프로그램에서반출한파일들을멘들레이로가져옵니다.

• Export : 멘들레이에저장되어져있는서지파일들을반출합니다. 
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You can also select a file or folder to add from your computer, or you can watch a folder. That means that any time you add a new document into that folder on your computer, Mendeley will import the document into your library automatically. If you like, you could add references manually instead. If you’re already using another reference manager, such as EndNote, RefWorks or Zotero, you can import your references directly into Mendeley. There are a few more ways to add documents to your library. You can use Mendeley’s Web Importer to add articles you’ve found online, for example on Google Scholar, or you can add articles by searching Mendeley’s crowd-sourced Research Catalog, which includes millions of papers. Let’s talk about that some more later.



My library 구축하기 – Watch Folder
• 이용자가 PDF 논문파일을주로저장하는폴더가있는경우, 

Watch Folder 로설정합니다.

• 해당폴더에이미저장되어져있는 PDF 파일들을모두가져오고, 
이후앞으로새로운 PDF 파일들이저장될때마다자동으로
멘들레이프로그램에구축됩니다. 
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You can also select a file or folder to add from your computer, or you can watch a folder. That means that any time you add a new document into that folder on your computer, Mendeley will import the document into your library automatically. If you like, you could add references manually instead. If you’re already using another reference manager, such as EndNote, RefWorks or Zotero, you can import your references directly into Mendeley. There are a few more ways to add documents to your library. You can use Mendeley’s Web Importer to add articles you’ve found online, for example on Google Scholar, or you can add articles by searching Mendeley’s crowd-sourced Research Catalog, which includes millions of papers. Let’s talk about that some more later.



Web Importer : Import from Web Databases 

• www.mendeley.com 로그인후첫페이지에서우측에있는 install the web importer 클릭

• Chrome & Firefox : 브라우저에탑재하는프로그램설치

• IE  :  “save to Mendeley” 메뉴를이용하는브라우져의북마크바혹은즐겨찾기모음에끌어다
넣습니다.  이후, 이용자의브라우저북마크바혹은즐겨찾기모음에 “Save to Mendeley” 라는
메뉴가보입니다.

17

Presenter
Presentation Notes
There are a few more ways to import documents into your library, such as by using the Web Importer, which lets you save references and PDFs you’ve found on the internet. If you go to our website, you’ll see this page, which explains how to install the Web Importer. Actually, ‘install’ makes it sound more difficult than it is. All you need to do is drag a button to your bookmark bar, and you’re done. That bookmark will tell Mendeley everything it needs to know to add an article to your library. I’ll show you what it looks like in action. 


http://www.mendeley.com/


Web Importer : Import from Web Databases by Chrome , Firefox

• Chrome Browser 이용시,
• 문헌검색후, 결과화면에서상단에있는Mendeley 마크를클릭하면
• 원하는문헌을저장할수있는 Pop-up 창이뜹니다.

Presenter
Presentation Notes
Any time you come across an interesting article online, or when you do a search on Google Scholar or one of our many  partner sites, you can save this article to your library by clicking ‘Save to Mendeley’. A window will then pop up, like the one you see on the right. Select any articles you’d like to import, and then click the green button to save them. Done! Mendeley will also save the PDF, it available.




반입하고자하는
파일을선택하여
“+” 클릭

• DB에서논문검색후, 검색결과화면에서 “Save to Mendeley” 를클릭합니다.

• 팝업창이뜨고, 논문을선택적으로혹은해당페이지에서보이는모든논문을Mendeley 에바로저장할수
있습니다. 

• ScienceDirect, American Chemical Society 등일부 Full Text DB 에서는 PDF 논문까지바로저장할수있습니다. 
( Wiley, IEEE 등의 Full Text DB 에서는서지데이터만저장)

Web Importer : Import from Web Databases by IE, Safari
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Any time you come across an interesting article online, or when you do a search on Google Scholar or one of our many  partner sites, you can save this article to your library by clicking ‘Save to Mendeley’. A window will then pop up, like the one you see on the right. Select any articles you’d like to import, and then click the green button to save them. Done! Mendeley will also save the PDF, it available.


http://scholar.google.com


Web Importer : 
약 54개의해외 DB에서이용

• https://www.mendeley.com/import/

• Save to Mendeley 메뉴가구현되는 Database 종류를확인할수있습니다.
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Any time you come across an interesting article online, or when you do a search on Google Scholar or one of our many  partner sites, you can save this article to your library by clicking ‘Save to Mendeley’. A window will then pop up, like the one you see on the right. Select any articles you’d like to import, and then click the green button to save them. Done! Mendeley will also save the PDF, it available.


https://www.mendeley.com/import/


Web Importer : Import from Web Databases 
• www.mendeley.com / Library 

메뉴에서는 Import한문헌
서지및파일이바로확인
되고,

• Web 에서 데스크탑
프로그램으로데이터를다운
받기위해서는

• SYNC 메뉴를클릭해야하고

• Recently Added 폴더에서
다운받은데이터를
확인합니다.
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Any time you come across an interesting article online, or when you do a search on Google Scholar or one of our many  partner sites, you can save this article to your library by clicking ‘Save to Mendeley’. A window will then pop up, like the one you see on the right. Select any articles you’d like to import, and then click the green button to save them. Done! Mendeley will also save the PDF, it available.


http://www.mendeley.com/


그 밖의 저장 방법 (특히, 국내 논문 검색 DB)
Export as “RIS format”, “Bibtex”, “Mendeley” “Endnote”

1 2

3

Web Importer 로문헌저장이
되지않는웹사이트의경우, 해당
사이트에서구축한서지파일을
직접다운받습니다.
주로국내논문 DB (RISS, Dbpia, 
NDSL 등) 이이에해당됩니다.

① 내보내기 (혹은인용하기, 
저장하기등)의메뉴를찾아

② Mendeley, RIS, Bibtext 혹은
Endnote 포맷을선택

③ 내보내기혹은다운로드
클릭

Presenter
Presentation Notes
Any time you come across an interesting article online, or when you do a search on Google Scholar or one of our many  partner sites, you can save this article to your library by clicking ‘Save to Mendeley’. A window will then pop up, like the one you see on the right. Select any articles you’d like to import, and then click the green button to save them. Done! Mendeley will also save the PDF, it available.




그 밖의 저장 방법 (특히, 국내 논문 검색 DB)
Export as “RIS format”, “Bibtex”, “Mendeley” “Endnote”

파일열기후, 멘들레이를해당파일의기본앱으로
설정하여열기합니다.

Presenter
Presentation Notes
Any time you come across an interesting article online, or when you do a search on Google Scholar or one of our many  partner sites, you can save this article to your library by clicking ‘Save to Mendeley’. A window will then pop up, like the one you see on the right. Select any articles you’d like to import, and then click the green button to save them. Done! Mendeley will also save the PDF, it available.




“Sync” your library 

iPhone, iPad  & Android

• 데스크탑메뉴의 SYNC를
클릭하여my library에있는
데이터를다른디바이스와공유
합니다.

• 모바일, 웹사이트에서이용자가
저장한서지데이터혹은 PDF 
논문을언제어디서나확인할
수있습니다. 24
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Any time you come across an interesting article online, or when you do a search on Google Scholar or one of our many  partner sites, you can save this article to your library by clicking ‘Save to Mendeley’. A window will then pop up, like the one you see on the right. Select any articles you’d like to import, and then click the green button to save them. Done! Mendeley will also save the PDF, it available.




폴더 및 Group을
만듭니다.

항목별로
filter 합니다.

항목별로 정렬 합니다. 

저장해 놓은
문서를 search 

합니다.

문서의 상세 내용이 자동
생성되고, 이를 수정 합니다. 
또한, tag 및 note 입력

합니다.

데스크탑 Overview
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This is what your Desktop Library looks like. The desktop is divided into three panes. They follow a workflow hierarchy from left-to-right. Any activity in the left pane affects the display of content in the center pane. Furthermore, any activity in the center pane is reflected in the right-hand pane, the document details pane.



Enter the DOI, 
PubMed, or 
ArXiv ID and 
click on the 
magnifying glass 
to start lookup

Mendeley adds missing info automatically

Look up documents by 
title on Google Scholar 
if they are flagged for 
review

Document Details
• 문헌의상세한서지사항리뷰및수정할수있고,
• DOI, PubMed, ArXiv ID 가활성화되어있는경우,클릭시분실된

내용회복시킬수있습니다.
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When you add a document to your library, Mendeley will do its best to import all the relevant data, but sometimes data may be missing. Fortunately, that’s easy to fix. Enter the DOI, PubMed or ArXiv ID and click the magnifying glass to help Mendeley find the right information. Mendeley will then add everything it found automatically. Sometimes Mendeley will flag a document for review, which means it will ask permission to check Google Scholar to fill in missing fields. At any point in time, you can manually edit fields as well.




Check for Duplicate
• My library에중복으로구축된서지를찾아Merge 할수있습니다.

• Tools -> Check for duplicates 메뉴이용

• 폴더단위로중복체크도가능합니다.
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Presentation Notes
This is what your Desktop Library looks like. The desktop is divided into three panes. They follow a workflow hierarchy from left-to-right. Any activity in the left pane affects the display of content in the center pane. Furthermore, any activity in the center pane is reflected in the right-hand pane, the document details pane.



기타 Option - General

Tools -> Options 

이용자가사용중인용량확인
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Any time you come across an interesting article online, or when you do a search on Google Scholar or one of our many  partner sites, you can save this article to your library by clicking ‘Save to Mendeley’. A window will then pop up, like the one you see on the right. Select any articles you’d like to import, and then click the green button to save them. Done! Mendeley will also save the PDF, it available.




기타 Option – Document Details
Tools -> Options 

Document 타입에따라논문서지내용의
Details 을구성하는항목을선택하여편집
가능
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Any time you come across an interesting article online, or when you do a search on Google Scholar or one of our many  partner sites, you can save this article to your library by clicking ‘Save to Mendeley’. A window will then pop up, like the one you see on the right. Select any articles you’d like to import, and then click the green button to save them. Done! Mendeley will also save the PDF, it available.




기타 Option – File Organizer
Tools -> Options 

Mendeley에구축되는 PDF file이자동저장
되는폴더및 저장형식 (이름) 편집가능
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Any time you come across an interesting article online, or when you do a search on Google Scholar or one of our many  partner sites, you can save this article to your library by clicking ‘Save to Mendeley’. A window will then pop up, like the one you see on the right. Select any articles you’d like to import, and then click the green button to save them. Done! Mendeley will also save the PDF, it available.




PDF 논문읽기
Using the built-in PDF Viewer
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Mendeley has a built-in PDF viewer which allows you to open multiple documents at a time, and add annotations and highlights to your PDFs. This is a great way to keep track of your notes



PDF Viewer 
• 데스크탑프로그램안에는 PDF viewer 가탑재되어있어
• My library에저장되어져있는 PDF 논문을바로열람할수있습니다.
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This is what your PDF viewer looks like. As you can see in the top bar, you can have multiple files open at one time in Mendeley, so you can work on several articles at once. Mendeley remembers where you were on the page, so you don’t waste any time searching for what you read last.



Read and Work in the PDF Viewer
• 데스크탑프로그램안에는 PDF viewer 가탑재되어있어
• My library에저장되어져있는 PDF 논문을바로열람할수있습니다.
• 원하는부분을 Highlight 하거나 Annotate (연구자노트)를기입하면서논문을읽습니다.
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Once you’ve found the article you were looking for, you can open and read it in Mendeley’s PDF viewer. Here, you can search through the article by keyword. Mendeley will highlight every instance of your keyword in the entire document. 




Export or Print PDF
• Highlight, Annotation 내용포함하여 PDF 파일을 export 하거나인쇄할수있습니다.

• ** 단, 한글로입력된 Annotate 은 ?? 로표기되는에러가있고, 현재수정중입니다.
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If you come across any words or terms you haven’t heard before, simply right click and choose ‘Define’ to look it up. Mendeley will then retrieve definitions and explanations for you.




Read PDF in Mendeley Web Library
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If you come across any words or terms you haven’t heard before, simply right click and choose ‘Define’ to look it up. Mendeley will then retrieve definitions and explanations for you.




Read PDF in Mobile
- iPhone, iPad, Android
-무료앱구입및설치

원하는부분선택
하이라이트, 노트추가
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If you come across any words or terms you haven’t heard before, simply right click and choose ‘Define’ to look it up. Mendeley will then retrieve definitions and explanations for you.




논문공유하기
Join and create groups to share references
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What makes Mendeley unique, is the ways in which you can collaborate with colleagues and friends, and discover new research. Share papers, make notes on the same articles, and meet new researchers in your field.




Group 만들기

3가지 그룹 종류

•Private Groups – 그룹 관리자가
초대한 사람만 그룹 가입 가능하고, 서지
및 PDF full-text 공유. 그룹 및 그룹
멤버는 외부로 공개되지 않음.

•Invite-only Public Groups – 그룹
관리자가 초대한 사람만 가입 가능하고, 
서지 추가 및 글쓰기 가능. 그러나, 
누구나 follow group 가능하여, 그룹의
내용을 참관 가능

•Open Public Groups – 누구나
자유롭게 가입 및 활동 가능한 그룹

MIE 구독기관이용자

• Private Group Storage : 20 GB 
• # of Private Groups : Unlimited 
• # of Users in Private Groups : 최대 25명
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Mendeley Groups help you connect to people and share references. There are three types of groups: Private, Public, and Invitation-Only Public Groups. You can create and manage groups in Mendeley Desktop as well as online at mendeley.com. Add documents to a group by dragging and dropping them into the group folder. 



Private Groups
• Private Group은그룹Member 들과 PDF Full Text 파일을공유할수있습니다.

• Private Group은mendeley.com 에서검색되지않고외부에노출되지않습니다. Member 
들끼리만공유됩니다.

• 그룹을만든사람뿐만이아니라그룹member 누구나파일을올릴수있고, 다른
member를초대할수있습니다. 
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The best type of group for collaboration is the private group. These are just that: Private. They cannot be found on the Mendeley Groups page, and no-one on the network knows they exist or who is in them. The owner must invite people to join, and members must accept to join the group. These groups are perfect for collaboration, because you can share full text documents and collaborate on research. You can only invite a limited number of members to join a private group.



• Private Group 에공유된논문은멤버들과공유되고열람됩니다. 더불어, 멤버들각자가해당
논문에 highlight 및 annotate 을남겨서서로다른의견들을교환할수있습니다

• 이는 Lab 단위혹은타기관과의공동연구의효율성이증대되는효과를가져옵니다.

Private Groups – Share papers & opinions
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When you’re a member of a private Mendeley Group, you can view the full text of papers, and collaboratively annotate and highlight documents. Mendeley automatically assigns a different color to each collaborator, so it’s easy to see who highlighted what, and who made which annotation. After you’ve worked on a paper, be sure to click ‘sync’ in your Mendeley library, so that your changes are sent back to the server for your fellow group members to see.




참고문헌생성하기
Using the Mendeley Citation Plug-In
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So how about your own papers? Mendeley’s Citation Plug-in will save you time by helping you cite references as you’re writing new research. No more tedious hours spent checking style guides and manually writing your bibliographies. Mendeley will do all the work for you!




MS Word Plug-in 설치
• MS word 프로그램과의호환되어논문작성시인용&참고문헌자동생성이가능합니다.
• Tools / Install MS word Plugin 을클릭하여설치합니다. 
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We like to make life easier for you, so installing the Citation Plug-in takes only a single step. From Mendeley Desktop, click ‘Install MS Word Plugin’ and Mendeley will do the rest. This works not only for MS Word, but also for LibreOffice. Now open your word processor to see the plugin.




참조메뉴에Mendeley Citation 툴설치

• 설치후, MS Word 프로그램참조란에Mendeley 관련도구가확인됩니다. 
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In MacOS the plugin looks like a bar that lists the functions of Mendeley. You can move this bar wherever you like, or you can hide it. If it ever accidentally disappears, don’t worry. Go to View, then Toolbars, and click ‘Mendeley Toolbar’ to make it re-appear. In Windows the plugin looks a little bit different, as you can see below. You can find it under the ‘References’ tab and the toolbar is integrated into the ribbon.




사용하고자하는참고문헌스타일을설정
① 데스크탑메뉴 View -> Citation Style ->  

More Styles 

② Installed 탭에서이미설치되어있는
스타일을찾아선택 -> Done 

③ Installed 에서검색되지않는스타일인
경우, Get more Styles 탭에서검색하여
Install  후, Installed 에서재검색하여
사용합니다.

** 스타일은스타일이름혹은저널
이름으로검색됩니다.

1

2
3



Citation 생성하기 –검색해서사용하기

① Insert Citation 입력후, 

② Mendeley 에저장되어있는문헌들중
키워드로인용하고자하는문헌을검색
합니다.

③ 문헌을찾은후, OK 를클릭하면, 
Citation 이입력됩니다. 

1

2

3
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Now imagine you’re working on your own research in Word. When you’re ready to add a citation to your paragraph, click ‘Insert or Edit Citation’. A new window will pop up. Simply type in the name of the author, part of the title, or the year, and Mendeley will show you a list of matches. You can also click ‘Go to Mendeley’ to pick an article from your library. Now click ‘OK’ to add the citation in Word, and it will appear.




Citation 생성하기
– Mendeley에서직접찾아적용하기

① Go To Mendeley 클릭하면

② Mendeley 데스크탑프로그램이열리고, 
인용하고자하는논문 (폴더를따로만들어
관리하면편리)

③ Cite 를클릭하여 Citation 을삽입합니다.

④ 2개이상의문헌도같이삽입하여
Citation 생성가능합니다.

1

3

2
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If you can’t remember the author or title of the article you’re looking for, or if you’d like to browse your library for more references, you can click ‘Go To Mendeley’ in the Citation pop-up. This button will open up your Mendeley Desktop, with one small difference. There will now be a temporary button in the top bar that says ‘Cite’. Select your reference from the list, and click ‘Cite’ to have Mendeley insert the citation and take you back to your Word document. 




Editing and Adding to Citations

3. Citation Editor 사용하여 page번호및다른
정보추가하거나 author 생략

①이미입력된 Citation 을선택하면, Insert 
citation 메뉴가 Edit Citation을
변경됩니다.

② Edit citation 클릭후, Citation 을
클릭하면

③ page 번호삽입혹은 author 생략등의
편집이가능합니다.
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You can edit your citation with Mendeley as well. To add page numbers or other information, select your citation and click ‘Insert or Edit Citation’ in the Mendeley toolbar. Now click on your citation to make an expanded menu appear, which you can see here towards the bottom. Now you can add page numbers, paragraphs, figures, or other details. You can also suppress the author here.



Inserting Your Bibliography

• Citation 삽입완료후

• Insert Bibliography 를
클릭하면, 선택되었던
참고문헌스타일에맞게
참고문헌이자동생성
됩니다.

• 참고문헌생성완료후, 
Style 메뉴에서다른
스타일로선택, 변경
가능합니다.

1

2
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When you have finished your work, and you’re ready to add the bibliography, click ‘Insert bibliography’ in the Mendeley toolbar. Mendeley will then generate your bibliography for you instantly. You know how some journals may ask for different citation styles than others? Well, gone are the days of manually rewriting your bibliography. Change all of your citations and your bibliography with the click of a mouse, by picking a different style from the drop down menu.




Mendeley 필드삭제

• 논문작성완료후논문
투고전에는Mendeley 
필드값을삭제해야
합니다.

• 원본파일은백업저장
하고,

• Without Mendeley Field 
형태로 Export 하여
저장하거나

• C  t r l + A (전체선택) -
C t r l + 6 (필드코드삭제) 
후저장합니다.
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참고문헌스타일편집하기 (고급)
Using the Mendeley Citation Plug-In

Presenter
Presentation Notes
So how about your own papers? Mendeley’s Citation Plug-in will save you time by helping you cite references as you’re writing new research. No more tedious hours spent checking style guides and manually writing your bibliographies. Mendeley will do all the work for you!




Journal Abbreviation (저널약어) 사용하기

Presenter
Presentation Notes
When you have finished your work, and you’re ready to add the bibliography, click ‘Insert bibliography’ in the Mendeley toolbar. Mendeley will then generate your bibliography for you instantly. You know how some journals may ask for different citation styles than others? Well, gone are the days of manually rewriting your bibliography. Change all of your citations and your bibliography with the click of a mouse, by picking a different style from the drop down menu.




① Cite Using 란에서
“Default”를선택하면, 
멘들레이가
자동으로생성한
저널약어로
참고문헌이
생성되고,

② Cite using 에서 new 
list를생성하여
이용자가원하는
Customized 저널
약어를직접생성할
수있습니다. 

Journal Abbreviation (저널약어) 사용하기

Presenter
Presentation Notes
When you have finished your work, and you’re ready to add the bibliography, click ‘Insert bibliography’ in the Mendeley toolbar. Mendeley will then generate your bibliography for you instantly. You know how some journals may ask for different citation styles than others? Well, gone are the days of manually rewriting your bibliography. Change all of your citations and your bibliography with the click of a mouse, by picking a different style from the drop down menu.




3.

Citation Style 편집하기 : The CSL editor
HTTP://CSL.MENDELEY.COM 

①HTTP://CSL.MENDELEY.COM 
① http://CSL.MENDELEY.COM 에접속하여
멘들레이계정으로로그인합니다. 

53



The CSL Editor 란 ?
• C S L 은다양한서지관리프로그램에서공동으로같이사용하는 Open Site 이며,
기존 Citation Style을기반으로편집하여, 나만의스타일을만들수있습니다. 
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The CSL Editor
http://csl.mendeley.com/about
-사이트에접속하여 “Search by name” 혹은 “Search by example”로스타일
찾아편집
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If you still can’t find the right style or you’d like to customize an existing style, you may want to try your hand at our CSL Editor, which lets you customize styles. Saved styles are added to the Mendeley database, and will appear in your drop-down menu in Word. 

http://csl.mendeley.com/about


스타일이름혹은 Journal 이름으로
스타일검색
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Search by Name으로스타일찾기

Presenter
Presentation Notes
If you still can’t find the right style or you’d like to customize an existing style, you may want to try your hand at our CSL Editor, which lets you customize styles. Saved styles are added to the Mendeley database, and will appear in your drop-down menu in Word. 



1. 스타일이름을모르는경우,
“Search by example” 에서

2. Citation & Reference 샘플을원하는형식
으로변경

3. 이용자가입력한형식과가장비슷한스타일
이검색됨

4. “Edit” 클릭하여원하는형식으로편집
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Search by example 로스타일찾기

Presenter
Presentation Notes
If you still can’t find the right style or you’d like to customize an existing style, you may want to try your hand at our CSL Editor, which lets you customize styles. Saved styles are added to the Mendeley database, and will appear in your drop-down menu in Word. 



5.

The CSL Editor 
- Citation 편집

1. 현재의 citation 스타일
2. 편집원하면클릭

3. 편집원하는 Layout 종
류클릭

4. Drag 방법으로순서변
경가능

5. 편집하고자하는스타일로변경
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The CSL Editor
- Reference 편집

1. 현재의 reference style citation 스타일
2. 편집원하는항목클릭

3. 혹은 BIBLIOGRAPHY 및MCROS에서
편집원하는항목클릭
4. Drag 의방법으로항목들의순서를
변경할수있음. 
(예. Name을클릭하여 author 위로
drag 해서자리옮김)

5. 원하는스타일로변경
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7.

6.

The CSL Editor

스타일을이름을설정합니다
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Save style  ( Style 이름은
자동으로 이용자의 이름으로
저장됩니다.)

7.새로편집 & 저장한 style 을
선택하여논문을작성합니다.

6.

The CSL Editor
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• C S L Editor 에 대한 보다 자세한 내용은 아래 URL 에서 확인하여 주세요.
– http://community.mendeley.com/guides/csl-editor
– https://github.com/citation-style-editor/csl-editor/wiki/Using-the-Citation-Style-Editor-

with-Mendeley-Desktop
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If you’d like to stay up to date with new developments in Mendeley, or if you’d like to learn new tips, you can stay connected by visiting our blog at blog.mendeley.com. If you’d like to learn more about specific features of Mendeley.com, check out our resource center online, or visit our YouTube channel. You can also connect with us on Facebook, Twitter, and see our photos on Flickr.



Reference Style 공유하기

• 내가만든스타일을
동료와공유하고자할때,

• Citation Style 에서나의
Style을찾아오른쪽
마우스클릭하여, “Copy 
Style Link” 하여 URL을
동료와공유합니다.



Reference Style 공유하기

• “Get more style”에서해당 URL을 “Download 
Style”란에붙이고 “Download” 를클릭하면,

• “Installed” 탭에서다운로드한스타일이검색
됩니다.



참고문헌생성하기 (LaTex & BibTex)
Using the Mendeley Citation Plug-In
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So how about your own papers? Mendeley’s Citation Plug-in will save you time by helping you cite references as you’re writing new research. No more tedious hours spent checking style guides and manually writing your bibliographies. Mendeley will do all the work for you!
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BibTex Preferences

• Mendeley 데스크탑 -> 
Tools  Options 메뉴
(MAC 에서는
preference 메뉴) 

• BibTex Syncing 에서
두번째 “Create one 
BibTex file per group”
선택

• BibTex파일생성
되어야하는위치를
Path 란에선택
합니다. 
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Autogenerate.bib file(S)

• 새로운폴더를하나
만들어서이번논문에
인용할문헌데이터를
모아놓은후

• Sync 메뉴를클릭

• Option에셋팅해놓은
대로이폴더에있는
문헌데이터들에
대한 .bib 파일이
생성될것입니다. 
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Autogenerate.bib file(S)

• Option메뉴 / Path 
란에설정해놓은
폴더에

• Meneley 폴더별 .bib 
파일이자동으로
생성됩니다.



Citing LaTex
• 인용하고자하는논문선택

• 오른쪽마우스클릭하여

• Copy as -> LaTex Citation 
Command로 copy  후

• LaTex 에붙여넣습니다. 
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Reference in LaTex

• LaTex로논문작성시,

• 좌측의예시와같이
참고문헌란에 .bib file 
경로를작성합니다.



72

Generate your PDF
• LaTex논문작성시Mendeley 활용방법

아래사이트에서좀더많은정보를확인할
수있습니다.

https://blog.mendeley.com/2011/10/25/howto
-use-mendeley-to-create-citations-using-latex-
and-bibtex/

http://libguides.mit.edu/c.php?g=176186&p=1
159535

https://www.youtube.com/watch?v=772BeD2f
HIQ (동영상)

https://blog.mendeley.com/2011/10/25/howto-use-mendeley-to-create-citations-using-latex-and-bibtex/
http://libguides.mit.edu/c.php?g=176186&p=1159535
https://www.youtube.com/watch?v=772BeD2fHIQ


논문검색/관심논문추천
New Research, Recommendations, and Impact
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As I mentioned before, Mendeley is a great way to discover new research, get recommendations, and to see the impact of articles on the research community. Let me show you how Mendeley can help!




Mendeley 
Catalog 
문헌검색

Full text 가능한
경우, 다운로드
icon 확인됨

One click 
으로 my 
library 에
저장됨

Literature Search 
• 전세계Mendeley 이용자들이저장받은문헌들이Mendeley Catalog에색인되어

통합적으로문헌을검색하고, 바로나의Mendeley library에저장할수있습니다.
-약 4억건의문헌을대상으로검색

• 데스크탑 -> Literature search 메뉴에서검색합니다. 
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The easiest way to find new research is by searching the Mendeley research catalog, which is generated by citations that are synced to the cloud and then made publicly searchable. There are over 200 million documents in the database, making it the world’s largest open research database. Mendeley organizes research as it is added to the database. Look at the most popular papers, or view the most recently added research. You can also browse by discipline and do keyword searches. If the full text of the article is available, you’ll see a download icon next to the title. If it’s not available, you can still add the reference to your library so you can use the information to find the full text.




Literature Search 
①원하는 Search Field를선택하여주제어를입력하고,
②검색된논문의 Details 를확인후, Save Reference를클릭하여나의Mendeley library에

저장합니다.
③Open access논문의경우, 바로 PDF full-text 파일을저장할수있습니다.
④ Details에서 “View research catalog entry for this paper”를클릭하면…

1 2

3

4
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Literature Search – Web Catalog
• Mendeley.com 웹상의해당

논문페이지로연결되어
추가내용을확인합니다.

① Fine this paper at 에서 Full 
Text 확보할수있는경로를
확인합니다. MIE 기관
그룹에가입한이용자는
해당학교의링크리조버
서비스를이용할수
있습니다.

②전세계Mendeley 
이용자들의독자통계를
확인하여, 몇명의어떤
이용자들이해당논문을
많이읽었는지통계
확인함으로써 , 논문의
영향력과인기도를파악
합니다.

③이논문과내용이유사한
다른논문들은어떤것들이
있는지자동으로
추천됩니다.

1

2

3
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Suggest –관심논문자동추천
• Mendeley.com  상단의 Suggest 메뉴를

클릭하면,

• 이용자가관심있을만한문헌들이자동으로
추천됩니다.

• 이용자가My mendeley에저장했거나읽은
논문들을기반으로

• 혹은 Profile에입력된주제분야와연관있는
논문들이추천됩니다.
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기타 Support 
Keeping in touch with Mendeley’s ongoing 
developments
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Mendeley wants to provide the best productivity and collaboration platform to every researcher, student and knowledge worker in the world. We’re helping to accelerate scientific progress, drive scientific discovery, and make research more open. Mendeley also supports the research community through outreach efforts in developing countries, contributions to the altmetrics project, and our continued advocacy for open access.
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If you’d like to stay up to date with new developments in Mendeley, or if you’d like to learn new tips, you can stay connected by visiting our blog at blog.mendeley.com. If you’d like to learn more about specific features of Mendeley.com, check out our resource center online, or visit our YouTube channel. You can also connect with us on Facebook, Twitter, and see our photos on Flickr.



Feedback
feedback.mendeley.com

• 멘들레이에제안하고자
하는내용을올리거나

• 다른사람들이올린제안
내용에투표하여

• 우선적으로개발될수
있도록할수있습니다. 
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Support
http://support.mendeley.com/
support@mendeley.com

• Mendeley Support 에서
자주묻는질문과답변을
확인할수있고,

• 이용중에문의사항은
support@mendeley.com
으로질의하면 24시간
이내에답변을받을수
있습니다. 
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Presentation Notes
Help make Mendeley even better by leaving us feedback. If you go to feedback.mendeley.com you can submit your own ideas and suggestions, or you can vote on other people’s ideas. Our developers check this page regularly for ideas, and they respond to our users to give updates on progress. If you have urgent questions, visit our support page at support.mendeley.com. Not only will you find thousands of articles addressing questions from users, but you can also submit your own questions and our support team will get back to you to help you troubleshoot, or to show you were to find more resources that explain our features. 

http://feedback.mendeley.com
http://support.mendeley.com/
mailto:support@mendeley.com
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기혜진차장

Email : b.ki@elsevier.com

온라인동영상 : 
http://korea.elsevier.com/elsevierdnn/kr/OnlineSolutions/Mendeley/tabid/2652/
Default.aspx

Support  (클레임및문의) 

http://support.mendeley.com/
support@mendeley.com

mailto:b.ki@elsevier.com
http://korea.elsevier.com/elsevierdnn/kr/OnlineSolutions/Mendeley/tabid/2652/Default.aspx
http://support.mendeley.com/
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